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Thank you very much for purchasing this product.
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To ensure correct and safe usage with a full understanding of this product’s performance, please be
sure to read through this manual completely and store it in a safe location.

Unauthorized copying or transferral, in whole or in part, of this manual is prohibited.

The contents of this operation manual and the specifications of this product are subject to change
without notice.

The operation manual and the product have been prepared and tested as much as possible. If you
find any misprint or error, please inform us.

Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may
occur through use of this product, regardless of any failure to perform on the part of this product.
Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may
occur with respect to any article made using this product.

Roland DG Corporation



——  For the USA

FEDERAL COMMUNICATIONS COMMISSION
RADIO FREQUENCY INTERFERENCE
STATEMENT

This equipment has been tested and found to comply with the
limitsfor a Class A digital device, pursuant to Part 15 of the
FCC Rules.

These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated
in acommercial environment.

This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference
to radio communications.

Operation of this equipment in aresidential areaislikely to
cause harmful interference in which case the user will be
required to correct the interference at his own expense.

Unauthorized changes or modification to this system can void
the users authority to operate this equi pment.

The /O cables between this equipment and the computing
device must be shielded.

—  For Canada

CLASSA NOTICE

This ClassA digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

CLASSE A AVIS

Cet appareil numérique de la classe A respecte toutes les
exigences du Réglement sur le matériel brouilleur du
Canada.

ROLAND DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODEL NAME : Seethe MODEL given on the rating plate.
RELEVANT DIRECTIVE : EC LOW VOLTAGE DIRECTIVE (73/23/EEC)
EC ELECTROMAGNETIC COMPATIBILITY DIRECTIVE (89/336/EEC)
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ATO Ensure Safe Use

Improper handling or operation of this machine may result in injury or damage to property.
Points which must be observed to prevent such injury or damage are described as follows.

About AWARNING and AACAUTION Notices

Used for instructions intended to alert the user to the risk of death or severe
AWARN ING injury should the unit be used improperly.

Used for instructions intended to alert the user to the risk of injury or material
damage should the unit be used improperly.

&CAUTION * Material damage refers to damage or other adverse effects caused with re-
spect to the home and all its furnishings, as well to domestic animals or pets.

About the Symbols

The /\ symbol alerts the user to important instructions or warnings. The specific meaning of
the symbol is determined by the design contained within the triangle. The symbol at left means
"danger of electrocution.”

The © symbol alerts the user to items that must never be carried out (are forbidden). The
specific thing that must not be done is indicated by the design contained within the circle. The
symbol at left means the unit must never be disassembled.

The @ symbol alerts the user to things that must be carried out. The specific thing that must be
done is indicated by the design contained within the circle. The symbol at left means the power-
cord plug must be unplugged from the outlet.

N>

( /N Incorrect operation may cause injury )

AWARNING ACAUTION

Never allow children near the machine. Install on a stable surface.
The machine includes locations and components Failure to do so may result in the unit tipping
that pose a danger to children, and major acci- over, leading to injury.

dent, including injury, blindness, or choking, may
occur. o Be sure to follow the operation proce-

dures described in this manual.

Do not disassemble, repair, or modify. Failure to follow the procedures may cause sud-
Doing so may lead to fire or abnormal opera- den operation or the like of the machine, which
tion resulting in injury. may result in unexpected injury.



&To Ensure Safe Use

( /\ Danger of electrical short, shock, electrocution, or fire )

ANAWARNING

Do not use with any electrical power sup-
ply that does not meet the ratings dis-
played on the AC adapter.

Use with any other power supply may lead to
fire or electrocution.

Do not use with any power supply other
than the dedicated AC adapter.

Use with any other power supply may lead to
fire or electrocution.

O 0 O

Never operate the machine or insert or
remove its power plug with wet hands.
Doing so may result in electrical shock or elec-
trocution.

¥

Never allow the machine to get wet, or
apply gasoline, thinner, or any other flam-
mable material to it.

Current leakage may cause electrical shock, elec-
trocution, or combustion and fire.

Never allow hairpins, coins, matches, or
any other object to get inside the machine.
Doing so may cause and electrical short, result-
ing in shock or electrocution, or the inserted
object may catch fire.

Never place gasoline, alcohol, thinner, or
any other flammable material near the
machine, or use an aerosol spray close to
the machine.

Doing so may cause fire.

Never damage the power cord or pull it
with force.

Doing so may tear the cord's insulation, causing
an electrical short and resulting in electrical
shock, electrocution, or fire.

O 0 © O

Never place any object on the power cord,
bend the power cord using excessive force,
or allow the power cord to become de-
formed.

If it becomes deformed, the deformed location
may grow hot and cause fire.

N

Never use the machine with the power
cord bound into a bundle or roll.

If the cord is in a bundle or roll, it may grow hot
and cause fire.

Never use any power cord other than the
power cord included with the machine.
Also, never use a power strip or extension
cord.

The power strip or extension cord may grow
hot and cause fire.

Do not use with a damaged AC adapter,
power cord or plug, or with a loose elec-
trical outlet.
Doing so may lead to fire, electrical shock, or
electrocution.

When unplugging the electrical power
cord from the power outlet,grasp the plug,
not the cord.

Unplugging by pulling the cord may damage it,
leading to fire, electrical shock, or electrocution.

N
N
0
0

In the event of an abnormal state (such as
smoke or sparks, odor or burning or un-
usual noise), immediately unplug the
power cord.

Failure to do so may result in fire, electrical
shock, or electrocution. Immediately disconnect
the power cord and contact your Roland DG
Corp.service center.

<

When not in use for several hours, unplug
the power-cord plug from the electrical
outlet.

Failure to do so may result in danger of electri-
cal shock, electrocution or fire due to deterio-
ration of electrical insulation.



ATO Ensure Safe Use

( AThe head area becomes hot )

AWARNING

® Never touch the head immediately after

printing has finished.
Doing so may cause burns.



&To Ensure Safe Use

( /N Warning Label )

Warning label is affixed to make areas of danger immediately clear. The meaning of the label is
as follows. Be sure to heed its warnings.
Also, never remove the label or allow it to become obscured.

A=A Caution: High Temperature
EAE——— % Never touch immediately after printing.
——




Important Notes on Handling and Use

This machine is a precision device.To ensure the full performance of this machine, be sure to
observe the following important points. Failure to observe these may not only result in loss of
performance, but may also cause malfunction or breakdown.

This machine is a precision device.

O Handle carefully,and never subject the machine to impact or excessive force.
O Never print material outside the range of specifications.

Install in a Suitable Location

O Install in a location having the specified temperature and relative humidity.
O Install in a quiet, stable location offering good operating conditions.

Important Notes on Connecting the Cables

0 Connect the power cord and the computer's input and output cables securely.

When Moving the Machine

0 When moving the machine, be sure to support it at the bottom using two hands. Attempting to move the
machine by holding it at a different location may result in damage.

O When moving the machine, turn the knob to secure the head in place.

0 When moving the machine to another location, be sure to attach the retainers. Attempting moving without
attaching the retainers may result in damage.

Printing

O Never attempt to perform printing on the edges or over holes in printing material.

O Printing results may vary according to the original data, the material printed, and the details of settings. Before
you perform actual printing, we recommend carrying out test printing.

O Attempting printing with no material loaded may damage the pins or heads.






Chapter 1
Getting Started




1-1 About the Machine

Features

This machine is a metal printer. It prints images by striking detailed points using a marking pin mounted in a head.

10 Chapter 1 Getting Started



1-1 About the Machine

Names and Functions

Main Unit
Cover
Head unit
This moves up and down, bringing the
tip of the head (the marking pin) in
line with the surface of the material.
Knob

This secures the head unit in place.

Adhesive sheet
Material is placed on the adhesive sheet, which then holds
the material in place. This lets you immobilize objects
:/ivlihout having to use commercially available tape or the Powgr/Mpvement bu_tton -
' Pressing this makes the light come on and switches
on the power. Pressing it while the unit is on moves
the table to the material-mounting location (toward
the front of the unit) or to the material-printing loca-
tion.
To switch off the power, you hold down the button
for one second or longer.

Power-code connector USB connector

Chapter 1 Getting Started 11



1-1 About the Machine

Head

’
’ ‘ -
\’ \j ‘ M_arki_ng pins _ o
Nine pins are arranged in the head. Printing
lp" is performed using one of these pins.

12 Chapter 1 Getting Started



1-2 About the Documentation

Included Documentation

The following documentation is included with the machine.

MPX-70 User's Manual (this manual)

This explains how to install and set up the machine, how to install and set up the software, how to perform printing,
and other such matters.

Dr. METAZAZ2 online help

This is the operation manual for the Dr. METAZA2 program included with the machine. Installing and setting up the
software enables you to view the documentation.
To view the online help, follow the procedure below.

From the [Start] menu, click [All Programs] (or [Programs]).
Click [Roland Dr. METAZAZ], then click [Dr. METAZA2 Help].

@ Foland Dr METAZA2 | fil T HETAZ
' (% orMETAZAZ Helo
"'.l,i_f-’[ Drmcinemz Uninstall
%P MPH-T0 Head Manaeer
W MPH-70 Head Manager Uninstall

Chapter 1 Getting Started 13



1-3 Checking the Included Items

The following items are included with the machine. Make sure they are all present and accounted for.

iy

AC adapter Power cord Test-use printing material

USB cable User's manual

(This document)

14 Chapter 1 Getting Started



Chapter 2
Getting Ready to Print
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2-1 Installation

Deciding On an Installation Site

Install the machine on a stable base in a stable location. Also, use the machine in a location having the correct
operating environment (temperature of 10 to 30 °C and relative humidity of 35 to 80% [with no condensation]).
Use in an unsuitable location may result in malfunction or breakdown.

ACAUT|ON Install on a stable surface.
Failure to do so may result in the unit tipping over, leading to injury.

Unsuitable Installation Sites

O Locations subject to large fluctuations in temperature or humidity

O Locations subject to shaking or vibration

O Locations where the floor is tilted, not level, or unstable

O Dusty locations

O Locations exposed to direct sunlight or near air-conditioning or heating equipment

O Locations exposed to considerable electrical or magnetic noise, or other forms of electromagnetic energy

Chapter 2 Getting Ready to Print



Removing the Protective Materials

2-1 Installation

Protective materials are attached to protect the machine from vibration and the like during transportation. Remove

these once the machine are installed.

[ Be sure to remove all protective materials.Any that remain may cause breakdown when the power is switched

on.
O The protective materials are required when moving the machine. Be sure not to discard it.
Procedure

[] Open the cover.

Remove the protective material A.

Protective material A

[] Loosen the knob.
The head unit rises.
Head unit

[]

Protective material B

Protective material B

Chapter 2 Getting Ready to Print
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2-2 Connecting the Cables

Connecting the Power Cord

AWARNING

Power cord

Do not use with any electrical power supply that does not meet the ratings dis-
played on the AC adapter.
Use with any other power supply may lead to fire or electrocution.

AC adapter

Important Notes on the Power Cord

AWARNING

AWARNING

AWARNING

AWARNING

AWARNING

Never damage the power cord or pull it with force.
Doing so may tear the cord's insulation, causing an electrical short and resulting in electri-
cal shock, electrocution, or fire.

Never place any object on the power cord, bend the power cord using excessive
force, or allow the power cord to become deformed.
If it becomes deformed, the deformed location may grow hot and cause fire.

Never use the machine with the power cord bound into a bundle or roll.
If the cord is in a bundle or roll, it may grow hot and cause fire.

Never use any AC adapter and power cord other than the AC adapter and power
cord included with the machine.Also, never use a power strip or extension cord.
The power strip or extension cord may grow hot and cause fire.

Do not use with a damaged AC adapter, power cord or plug, or with a loose electri-
cal outlet.
Doing so may lead to fire, electrical shock, or electrocution.

Chapter 2 Getting Ready to Print



2-2 Connecting the Cables

Connecting to the Computer

You make the connection to the computer using the included USB cable.
Be sure to make the connection between the machine to the computer during the course of installing the driver.

Driver installation may fail and the machine may become unusable if you connect a USB cable before starting install-

ing the driver.

Machine
Computer
° °
L] ]

DO NOT connect a USB
cable at this point.

] e

USB cable (included)

Important Notes on USB Connection

O Never use a USB hub or the like.
O Connect one single machine to a single computer. Never connect two or more machines to one computer.

Chapter 2 Getting Ready to Print 19



2-3 Installing and Setting Up the Software

Overview of the Included Software

The included CD-ROM contains the following software.

Dr. METAZAZ2

This is a program for printing images on the surface of printing material using this machine. It enables you import and
crop images to print, and perform editing to add text, boxes, and the like.

MPX-70 Head Manager

This is a utility for adjusting the head. Run it when you replace the head or adjust the marking pins.

Windows-based drivers

These are necessary for sending data from Windows to the machine. Be sure to install them.

System Requirements

System Requirements for Installing the Software

Operating system Windows 98 SE (Second Edition)/Me/2000/XP
Computer Computer running Windows (Pentium processor or better recommended)
Drive CD-ROM drive
Monitor 16-bit color (High Color) video card with a resolution of 800 x 600
Memory (RAM) 64 MB or more recommended
Free hard-disk space required for 10 MB
installation
Interface USB port

System Requirements for USB Connection

Making a USB connection with Windows requires use of a computer that meets all of the following system require-
ments. Please note that other configurations cannot be supported.

Operating system

Windows 98 SE (Second Edition)/Me/2000/XP

Computer

1) Computers preinstalled with Windows 98 SE/Me/2000/XP at the time of purchase
(This includes such computers later upgraded to Windows Me/2000/XP.)
2) Computers on which USB operation is assured by the manufacturer of computers

20 Chapter 2 Getting Ready to Print



2-3 Installing and Setting Up the Software

Installing the Driver

Never make the connection to the computer before installing.

Keep the machine and the computer unconnected until you carry out this installation operation. Failure to follow
the correct procedure may make installation impossible.
[0 p 75 "What to Do If Installation Is Impossible"

[ ] Before you start installation and setup, make sure the USB cable is not connected.
[ ] Log on to Windows. If you are installing under Windows 2000/XP, log on as "Administrators” right.

[] Olnsert the included CD-ROM into the CD-
ROM drive.
After a short wait, the setup menu shown at left ap-
pears.
OClick [METAZA Driver Install].
An Installation and Setup Guide matched to the basic
@GGME‘TJ&JZA@ Install Readme software on your computer is displayed.
- ) If you're using Windows 98 SE/Me/2000, the Installa-
GAETIATES Drive Read ’
” o r e tion and Setup Guide and the Setup program appear.
MPA-T0 Head Manager Install Readme
http: /fwww.rolanddg.com/

[ ] Follow the instructions in the Installation and Setup Guide to finish installing.
E? MPX-70 Driver Installation and Setup Guide [9(i=1E3)

e g &
Back Forward  Font Frint

MPX-70 Driver

Installation and Setup Guide

& Important

Do not connect iﬁg MPX-70 1o the computer until you are instructed 1o x|
make the connection.

Failure to follow the correct procedure may make installation © Install

impassiole. £ Uninstall

Installation of the driver requires full access rights for the computer,
Log on to Windows with a computer administrator account.

Model:

) [Roland MP=70 |
Wihen you are connecting the MPX-70 to the computer using a USE cable,
follow the steps below to install the driver, Port
IUSE - COM Config
1. Connect the MPX-70 to the computer using a USB cahle, then
switch on the power to the MPX-70, - -
The [Found MNew Hardware wizard] appears, ¥ il
Installation and Setup Guide Setup program

(Windows 98 SE/Me/2000)

If the [Driver Setup] Window Doesn't Appear

If you're using Windows 98 SE/Me/2000 and the Setup program doesn't appear, first check the taskbar at the
bottom of the screen. If [Driver Setup] is displayed, the program is running. Go to the taskbar and click [Driver
Setup] to display the window for the Setup program. Taskbar

iaﬁtartIH (%) Raland Software Packa., | IE—-Q MPX-70 Driver Insta... m I— Click this.

Chapter 2 Getting Ready to Print 21
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2-3 Installing and Setting Up the Software

Installing DrMETAZA2

Procedure

D © Roland Software Package for METAZA X 0 D|5p|ay the Setup menu.
==Roland i OClick [Dr.METAZAZ2 Install].

ez AT Readme

LAEATLLE, Driver Install Readme

MP#-70 Head Manager Install Readme

http://www.rolanddg.com/

[ ] Thereafter, follow the instructions in the messages to complete installation and setup.

Installing MPX-70 Head Manager

Procedure

[] © Roland Software Package for METAZA % O DISplay the setup menu.
mmRoland _ OClick [MPX-70 Head Manager Install].

Bz fAETATZA 72 Install  Readme

LAETATZE, Driver  Install Readme
o)

@
MPHA-70 Hsad Manager Readme

http://www.rolanddg.com/

[ ] Thereafter, follow the instructions in the messages to complete installation and setup.
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2-4 Dr. METAZAZ2 Settings

Making the Setting for the Printer

After you finish installing and setting up Dr. METAZA2, continue by making the setting for the printer. Be sure to make
the setting before use.

Procedure
0 BN Click [Start], then click [All Programs] (or [Pro-
B TrecTeses TR grams)).
@ DrMETAZAZ Uninstal Click [Roland Dr. METAZAZ?], then click [Dr.
§F MFX-70 Head Manager METAZAZ].

T MPX-70 Head Manager Uninstall

D m Untitled - Dr.METAZA? GO to the [Flle] menu and CI|Ck [P”nt Setup]
SN Edit View Ohject Help The [Print Setup] dialog box appears.
Mew. .. Chrl+HM
Open... ChrHO
Save ChrHa
Sawve As...
Import...
Export 3
Material Setup. ..
Add Material 3
Seleck Source.. .
Acquire...
Chrl4+P
i Preferenres. ..
[ Print Setup ?)X] OClick the arrow shown in the figure,

itz O then select [Roland MPX-70].
MName: Foland MP-70 @ Properties... D C“Ck [O K] .

Status: Feady
Tupe: Roland MF<-70
Wwhere:  USBOOT

Commet:

Faper Orientation

Size: |User Size j " Partrait

| =l e
MNetwark. .. @ Cancel

Chapter 2 Getting Ready to Print
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Chapter 3
Performing Printing
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3-1 Switching the Power On and Off

Switching the Power On and Off

Before You Switch On the Power

Before you switch on the power, be sure to loosen the knob and raise the head.
Otherwise the head may scrape and damage the adhesive sheet.

Switching On the Power

UOpen the cover.

[lLoosen the knob.

Loosen just enough for the head unit to rise.

[Press the Power/Movement button.

The light comes on. The table moves and initialization begins. The
power-on initialization performs origin detection, and so a noise
may be heard.

Power/Movement button

Head unit

Switching Off the Power

Hold down the Power/Movement button for one second or longer.
The light goes dark and the power is switched off.
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3-2 Starting Dr. METAZAZ2

Starting Dr. METAZAZ2

fi Rolsnd DrMETAZAZ q 59 DrveTAZA? Click [Start], then click [All Programs] (or [Pro-
- BTV ey grams]).
T DrMETAZAZ Uninstal Click [Roland Dr. METAZAZ2], then click [Dr.
? MP¥-70 Head Manager METAZAZ]

B MPX-T0 Head Manager Uninstall

After the opening screen, the screen for Dr. METAZA2 appears.

Names and Functions of Dr. METAZAZ2 Screen ltems

Menu Bar
Runs the various commands for Dr.METAZA2.

P2 Untitled - Dr.METAZA? ===

\E Edit  ¥iew b]e:t Help )
CTEEHEE|) BB XE | o ) i Toolbar

The toolbar is provided with buttons for running
Dr.METAZA2 commands such as [Open...] and
[Save]. Moving the mouse pointer over a button
displays a brief description of the button's func-
tion.

Material

The combined black and gray areas indicate the
material.

To decide on the size and shape of the material,
then from the [File] menu, click [Material Setup].

Centerline
This indicates the vertical center location of the
window.

(D#=Ge s erprr|~-OBERE

Margin
The gray area indicates the margin. The margin
areas are not printed. The default margin is 1 mm.

Grid
This is a grid of lines displayed on the screen. It
serves as a guide for positioning images and text.

i, T, | | mm= To hide the displayed grid, click [#] to clear the
‘ selection.

Centerline
This indicates the horizontal center Status Bar

location of the window. This shows Dr.METAZA2's state of operation and
provides brief descriptions of commands.
Cursor location This also shows amount of zoom in or zoom out
This indicates the present location of the cursor. You for the image.
can use it to check the locations of images and text.
The position at the center of the window (where the
two centerlines intersect) is (0, 0).
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3-3 Getting Ready to Print

The Printing Area

The machine's printing area is as follows.

Expanded printing area

Top view of the table (80 x 80 mm (3-1/8 x 3-1/8 in.))

Center line Printing area
(50 x 50 mm (1-15/16 X 1-15/16 in.))

‘ 2

50 mm 80 mm

. Iine J

« 50 mm >

+— 80mm —»

Preparing Material to Print

Prepare material that meets all of the following conditions.
Loading material that is larger or thinner than this may cause the material to warp during printing and strike the head,
damaging the marking pin.

Conditions for Materials that Can Be Printed

Thickness 0.3t0 20 mm (0.01to 0.8 in.)

Size Length (or width) of 90 mm (3-9/16 in.) or less

* Note that even if thickness and size are within the range as described above, it may not be possible
to perform printing correctly on materials that warp when struck. Refer to the table below, which

provides a general guide to printable sizes according to thicknesses.

Material Thickness Printable material size (general guide)
Aluminium 2.0 mm (0.08 in.) Length (or width) of 60 mm (2-3/8 in.) or less
1.5 mm (0.06 in.) Length (or width) of 40 mm (1-9/16 in.) or less
1.0 mm (0.04 in.) Length (or width) of 30 mm (1-3/16 in.) or less
0.5 mm (0.02 in.) Length (or width) of 20 mm (3/4 in.) or less
0.3 mm (0.01in.) Length (or width) of 20 mm (3/4 in.) or less
Brass or copper 2.0 mm (0.08 in.) Length (or width) of 60 mm (2-3/8 in.) or less
1.5 mm (0.06 in.) Length (or width) of 40 mm (1-9/16 in.) or less
1.0 mm (0.04 in.) Length (or width) of 30 mm (1-3/16 in.) or less
0.5 mm (0.02 in.) Length (or width) of 15 mm (9/16 in.) or less
0.3 mm (0.01in.) Length (or width) of 15 mm (9/16 in.) or less
Stainless steel 2.0 mm (0.08 in.) Length (or width) of 60 mm (2-3/8 in.) or less
1.0 mm (0.04 in.) Length (or width) of 40 mm (1-9/16 in.) or less
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3-3 Getting Ready to Print
. _________________________________________________________________________________________________________________________________________________________________|]
Hardness of surface Vickers hardness (HV) of 200 or less
to print * Note that materials which may crack or split by printing (such as glass, stone, precious

stones, china, and porcelain) cannot be printed even if hardness is within the preceding range.
Attempting to print such materials may damage the machine.

Cross-section of Flat, with no difference in level
printing material The printed surface must be level when the material is placed on the table.

X X X X

| - | | 1 |

Edge of the Surface to print Back surface is Back surface is
material is too is not straight. curved. uneven.
high.

Preparing the Image

Prepare an image (such as a photograph or drawing) for printing.
Data in JPEG or BMP format can be used with Dr. METAZAZ2.
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3-4 Loading Material

Mounting Material on the Table
Procedure

UOpen the cover.

[Loosen the knob.

Loosen just enough for the head unit to rise.

[Press the Power/Movement button to move the table to

the front of the machine.

Head unit Power/Movement button

Place the material on the table and press down on it gently
to secure it in place.

Table

Material

How to Place Material
Place the material at the center of the scale on the table.

Center line
( N\ Table
\ Center line
G 7) Center of the material

About the Adhesive Sheet

0 Buildup of dust or the like on the adhesive sheet can reduce the sheet's adhesive force, making it difficult to
secure material in place. If the adhesive force has been reduced, then wash the adhesive sheet.

[J p 62 "Cleaning the Adhesive Sheet"
U Never rub the surface of the adhesive sheet with force. Doing so may damage the surface and reduce its

adhesive strength.
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3-4 Loading Material

Press the Power/Movement button.
The table moves to the center.

Power/Movement button

UPress the location shown in the figure to lower the head
unit slowly to where it touches the material.

UKeeping the area shown in the figure clamped, turn the
knob to secure the head unit in place.

Press here.

Ty

W .
J) Lower the metal bar to a location where

\
it touches the material.

Notes on Loading Material

When you lower the head unit, the metal bar also descends, and contacts the material. Secure the knob in place at the
location where contact is made with the material. The metal portion rises slightly when released, but this does not
affect the loading of the material.

Important!

U Lower the head unit slowly. Lowering it too quickly or forcefully may damage the surface of the material.
U When you lower the head unit, be sure to press it at the location specified in the procedure. Pressing it at
another area may cause inaccurate height alignment.

Close the cover.

Detaching the Material

Loosen the knob, raise the head, then remove the material.
If the material is difficult to detach, inserting a thin, flat object (such as a piece of stiff paper or cardboard) between the

adhesive sheet and the material may make it easier to dislodge.
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3-5 Creating Printing Data

This section describes how to create data, using printing of a plate like the one shown below as an example.

I mm(0.039in.)#:

(Margin)

27 mm
(I-1/16 in)

y

24 mm
(15/16 in)

Step 1 : Decide on the Size and Shape of the Material

Important Notes on Printing

Be sure to ensure a margin of | mm or more at each edge of the material. Also,avoid printing at areas where there
are holes in the material. The marking pin may be damaged if it strikes an edge or the like on the material.

O/m X — —

Printing area Printing area Printing area Printing area

N~ N N N S

The printing area No margins are The printing area
I 'mm I mm lies over a hole. present at the edges  extends beyond the
of the material. material.

Procedure

Enter the material's size (outer dimensions), then choose the shape.
In this example, enter 24 mm by 27 mm for the size and choose "quadrilateral” as the shape.

[] I Untitled - Dr.METAZA2 Go to the [File] menu and click [New].
M Edit View Object Help The [Material Setup] dialog box appears.
I [T m‘
L] Material Setup @ X UOFor the material's size, enter 24 mm for [Width] and 27
e . mm for [Height].
1) wiar G UChoose [ O ] for the shape of the material.
Height ’2?1— Cancel D C|ICk [OK].

A quadrilateral measuring 24 mm by 27 mm appears in the win-

Shape
p dow, with 1 mm margin formed around the quadrilateral.

AERSEE
Other..
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3-5 Creating Printing Data

Step 2 : Import the Image

Here you import the image to print. Prepare an image file to import.

Procedure

I ) Uniitied - Dr.METAZAZ Go to the [File] menu and click [Import].
G Edit View Object Help The [Open] dialog box appears.

Mew, .. Chrl+M
Qpen... ChrHO
Save Chr+3
Save fs...

[] O At [Look in], select the location of the file.

_. @ OELLEEE UAt [Files of type], select either [Bitmap file] or
- [JPEG file].
@ USelect the file you want.

V Click [Open].
The specified image is imported and displayed so as to
match the size of the material.

N
File name: ]tesl.bmp
Files of type (| Bitmap file [*.bmp] @] Cancel

[ Untitled - Dr.METAZA2 CEX

File Edt View Object Help

DBEHER| & 2@ X@ o -

@ 2
" A
g I mm
n TR
]
J,,
®
- ’
N = &
o " e 27 mm
= .
& —
+
[
v
_’
| mm

Cursor: 13,18, -1,90 mm [Position: 000, 0.00 mm Size: 24.00,|26.02 mm 100%

< P

24 mm
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3-5 Creating Printing Data

Step 3 : Save the File

Save the printing data in a file.

Procedure

I ) Untitled - Dr.METAZAZ
5-8 Edit ¥iew Object Help

Go to the [File] menu and click [Save As].
The [Save As] dialog box appears.

MNew, .. Chrl4+r

Open... ChrH0

Chrl+3
Import...
o (For [Save in,specify where to save the file.
Save_in: O OType in a file name.
||-QProgram D CI'Ck [Save].
|y 5amples
@_ 3
File name: @
Gave a3 hype: 1Dr.METAZA2 File [*.dmz) L] Cancel
-
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3-6 Starting Printing

Starting Printing

Procedure

P2 Untitled - Dr.METAZAZ
5-8 Edit View oObject Help

Go to the [File] menu and click [Print].
The [Print] dialog box appears.

Mew. .. Chrl+1
Open... ChrH+O
Save Ctr+3
Save As...

Impork. ..

Expark 4

IMaterial Setup...
Add Material 3

Select Source...
Acquire. ..

DT

Princ Freview. .,

(W i @3] [IMake sure [Roland MPX-70] is chosen as the
Prinler @ - printer name.
Mo B OClick [Properties].

Status: Ready
Tvpe: Faland MP-70
Where: Useom

Comment: ™ Print ta file
Print range Copies

(o Mumber of copies: m
oo El]r

& Roland MPX-70 Properties

g Material 7| g Option

Conection Yalues

UClick the [Image Correction] tab.

Select [Material].

Select either the composition or the product code of
the material.

OClick [OK].

Dark Bright
Erightness [0 ﬂ J ﬂ
Laww High

Contrast ’U_ ﬂ J ﬂ

Dark Bright

amma 050 ﬂ J ﬂ Set Standard

Material

@ b Detailz

7 lest
= Fhoto
" HighResolution

[~ Mior Image

METAZA

IMETAL FPRINTEF MEX

@ m{ Cancel H Help

Selection of the Material

When you select the composition of the loaded material, printing is performed using an optimal striking force for the
composition.

[ p 57 "AWide Variety Settings You Can Make with the Driver"
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3-6 Starting Printing

0 Click [OK].

The printing data is sent to the machine and printing

Properties. .. starts.

Frinter
Mame;
Statug: Ready
Type: Fioland MPx-70
Where:  USBODT
Comment: [ Print to file
Print range Copies
o all Mumber of copies: 1 33
O F r
-
Cancel
Important!

Never attempt printing in any of the following situations. Doing so may damage the pins or heads.

[0 When no material is loaded

U When the head unit is not set at a height accurately matched to the thickness of the material
[0 p 30 "3-4 Loading Material"

When Printing Ends

UAfter printing has finished, open the cover.

[ILoosen the knob.

[IDetach the material.

If the material is difficult to detach, inserting a thin, flat object (such
as a piece of stiff paper or cardboard) between the adhesive sheet
and the material may make it easier to dislodge.

After printing has finished, be sure to loosen the knob and raise the head.
This prevents damage to the head and the adhesive sheet.
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3-6 Starting Printing

Stopping Printing Operations

[] Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Click [Settings], then click [Printers].

[] Tl Double-click the [Roland MPX-70] icon.

Foland
MP-70

[] At the [Printers] menu, click [Cancel All Documents] (or [Purge Print Documents]).

& Roland MPX-70

Sial= Document  Wiew  Help
Skatus ner Pages Size Subr
Sat s DeFaulk Printer Printing 1 337 KB/384 KB 71374
Pri;t\ng Preferences...
Sharing... L4
Lise Prirker OFfline his printer,

Propetties

Close

If you're using Windows XP, then click [Yes].

[] Make sure the printing data has disappeared from the window and operation of the machine has
stopped.

[] Hold down the Power/Movement button for one second
or longer to switch off the power.

iz

\

Power/Movement button
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4-1Tips and Tricks for Image Layout

Tips and Tricks for Image Layout

Lay out the image and create data like the following.

Original image

L]

BN hintitiact -0l | LAY
T B dv ded Bi
|1 ke s 2P XE o

STHe & ¢

Trim away everything
except the area to print.

e ]

Import the image.

Step 1 : Cut Out the Required Image
[J p 33 "Step 2 : Import the Image"

[0 p 41 "Step 1 : Cut Out the Required Image"

Make the settings for the material.
[ p 32 "Step 1 : Decide on the Size and Shape of the Material"
Trim the original image

to leave just the
required portion.

Completed data

P Untitled - Dr.METAZAZ
Eile Edit View Object Help

DEEHER &« BEXE < -

Completed view

Xy CLENR G

(7 #|o |3 2

Cursor: 6,99, =722 mm Position: 0,15, -1.54 | rm Size: 19.45, 21.66 mm 100% /|

I
Step 3 : Enclose the Image in a Circle Step 2 : Adjust the Location and Size of

[J p 43 "Step 3 : Enclose the Image in a Circle" the Image
[ p 42 "Step 2 : Adjust the Location and Size of the Image"
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Step 1 : Cut Out the Required Image

Trim the original image to leave just the required portion.

[

O Ele

1 Untitled - Dr.METAZAZ
File Edit Wiew Object Help

EEIX

DEHESR|[ % BB XE - o

EEAFAENIERY e LT XCl|
S,

[Cursor: -17.91, 21.70 mm

|Position: 0.00, 0.00 mm

Size; 20.00, 20.85 mm

|100% /]

Erame...

Symbal..,

Text ]
Add Parts 3
Pen Setup...

Fucace 1tmage. ..

Crop Image...

Move Center

Properties. .. Alt+Enter

Trimming Picture

A0 |

A OO

20

OClick

4-1Tips and Tricks for Image Layout

o

OClick the image.

At the [Object] menu, click [Trimming].
The [Trimming Picture] dialog box appears.

o

¥ KeepAspect
Size [mm]——
“width [19.45

Height|21.66

Trimming area

OClick [Free].

ODrag inside the shaded-line box to
change the location to trim.

Drag the pointer ( [l| ) to change the
trimmed size.

OClick [OK].

The trimmed image only is displayed in the
window.
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4-1Tips and Tricks for Image Layout

Step 2 :Adjust the Location and Size of the Image

Adjust the layout and the size of the image. Keep adjusting the location and size until you achieve the layout you want.

Adjusting the Location

Click , then click the image.
bsEeR iBEXE - Drag to adjust the location.

@

M

=

O

2|

3

A

%

J &= B R

Cursor: 6.99, -7.22 mm Position: 0.15, -1.58 mm __[Size! 19,45, 21.66 mm 100%

Adjusting the Size

Click , then click the image.

e nenimEXES Drag the pointers ( [ll) at the four corners of the image to
@ adjust the size.

%

F

o

L >

3

EY

kY

P4 o 30

Pointers

Cursor: -24.38, 11.34 mm Position; 5.05, -5.33 mm _[Size: 9,09, 10.14 mm 100%
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4-1Tips and Tricks for Image Layout

Step 3 :Enclose the Image in a Circle

Use a frame to enclose the image in a circle.

[] e At the [Object] menu, click [Frame].
F The [Frame] dialog box appears.

Text ¥
Add Parts 3
I = - []l=0]t3) OFor the frame, select [03].

OClick [Insert].
A frame is inserted into the window.

04 05 06

s g
$ £
g b
i
Tomcigraiien v

Add... Delete Cancel
s | s |
— —

[] (R =ik Drag the pointers ( lll ) around the frame to
DSASR s m@ExE - adjust its size and location.
Z Adjust the location and size so as to enclose the im-
age. The adjustment methods are the same as the meth-
ods for adjusting the location and size of an image.
» [ p 42 "Step 2 : Adjust the Location and Size of the Image"
[
A,
%

Frame

J+o 0

Cursor: -21.65, 7.74 mm Posiion: 5.2, -5.47 mm___ Size: 10.50, 12.20 mm 100%
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4-2 Tips and Tricks for Text Layout

Tips and Tricks for Text Layout

Arrange text and create data like that shown in the figure.

Dr. METAZAZ2 screen

Ef Untitled - Dr.METAZAZ2 EEX

Ele Edt View Object Help

DEEHER $2E XE o

Completed view

e r 7~ BRREC

pJ# 3L

Curstr: 13.18, -1.90 mm Position: 0,00, 0.|) mm Size: 20.00, 20,85 mm 100%

1. Lay out the text horizontally.
[ p 45 "1. Arranging Text Horizontally"

Dr. METAZAZ2 screen

¥ Untitled - Dr.METAZA2 FER

File Edt View Object Help

DEHESR & 2@ XE

Completed view

b 7 - OBW® <

J#E &L

Cursor: 13,18, -1,90 mm Position: 0,00, 0,01 |mm Size: 20,00, 20,85 mm 100%

2.Arrange in the shape of a fan.
[ p 48 "2. Arranging in the Shape of a Fan"
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4-2 Tips and Tricks for Text Layout

1.Arranging Text Horizontally

Type in the text to arrange horizontally in the image.

Procedure

Go to [Object] menu, click [Text].
Select [Horizontal Text].

L]

Frame...
Swmbal..

Fan 1ext

Add Parts
Text Block

Pen Setup...

Click the location where you want to insert text.
The [Text] dialog box appears.

Line up the pointer with the location
where you want to insert.

0Go to [Text] and enter the text.
OClick [OK].

The text appears in the window.

X

Text (Happy Bitthday!] _®
Font Arial LChange... Font Color I:l'

I Fill Background

: 562
Horizontal mim Back Color —J

R
zzr
I Yertical [11.61 mm

Puasitior

Size:

I Width [13.98 mm ™ Rotate Text
; i ABC

Height (23 mm

Fotation Angle

iD deg
- I
Cancel
S =l

You can adjust the size and layout of the entered text, and change the typeface.

[ p 46 "Adjusting the Layout and Size of Text"
[0 p 47 "Changing the Font Style"
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4-2 Tips and Tricks for Text Layout

Adjusting the Layout and Size of Text

Changing the Size
Dragging the pointers ( JJ]) of the text box changes the size.

Changing the Layout

Dragging the center of the text moves it up, down, or to the left or right.
You can rotate the text by dragging it at a location to either the left or right of its center.

Cursor for movement up, Cursor for rotation
down, or to the left or right
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4-2 Tips and Tricks for Text Layout

Changing the Font Style

Procedure

[7 N Double-click the text string.
e The [Text] dialog box appears.

.4l Click [Change].
Tet [Hopmy Bithas] The [Font] dialog box appears.
Fonl  larial FontColor [ |/
Position-

I Fill Backaround
— 562
ﬁ_, Horizontal mm Back Color |
5 Vatical [1161

Size
i widh [1396 [~ Rotate Text
h g Height {23 mm ABC
Fotation Anale
0 deg

L]

Eant: Font style:
[eial

m
Qe

[OMake the selections for the font,style,and size
= @ OClick [OK]. _
T v i The [Text] dialog box appears again.
T fvartGarde Bk BT Bold
T AvaniGarde Md BT Blold Italic
B BankGothic MdBT
T Batang
H BatangChe v
Sample
AaBbYyZz
Seript: .

D Text E‘

Click [OK].
L The typeface of the on-screen text changes.
Fort  |rial Change FortCalor [ ]|+
Puosition

I Fill Background
] i 552
I Horizontal mm Back Color |
Vertical |-11.61 mm

Size
| width [1398 mm [~ Botate Text
Height 23 mm ABC

FRotation Angle

_+ [0 deg

Caneel
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4-2 Tips and Tricks for Text Layout

2.Arranging in the Shape of a Fan

Procedure

Go to [Object] menu, click [Text].
Select [Fan Text].

Add Parts

Pen Setup, ..

Click the location where you want to insert text.
The [Fan Text] dialog box appears.

Line up the pointer with the location
where you want to insert.

OGo to [Text] and enter the text.
Text @ DC“Ck [OK]

The text appears in the window.

L]

Font farial Changs... Font Calar l:l -

Puositior @
I~ Eill Background 4
iD " _a
Horznta! it Back Calor o
Wertical 10 mm 3

Size I Inwert Text

180 deg Radius 1141 mm I~ Rotate Text

i A
b Height 12. mm )
- i_;\ e
”

3
r
N
)5
Rotation Angle

@ o) coe |

You can adjust the size and layout of the entered text, and change the typeface.
[ p 49 "Adjusting the Layout and Size of Text"
[0 p 50 "Changing the Font Style"
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4-2 Tips and Tricks for Text Layout

Adjusting the Layout and Size of Text

Changing the Size
Dragging the pointers ( JJl]) of the text box changes the size.

Changing the Layout

Dragging the support point moves up, down, or to the left or right.
Dragging inside the text box rotates the support point around the reference.

Cursor for movement up,

down, or to the left or right Support point

Cursor for rotation
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4-2 Tips and Tricks for Text Layout

50

Changing the Font Style

Procedure

[] __ Double-click the text string.

The [Fan Text] dialog box appears.

Fan Text

Tent

X

‘Happy Birthday!

Rlotation Angle

Font Al FortCaor [ ||
Pastion I~ Fil Backagiound
s
1 I Herzontal {0 pam BeacleColoy
b Yebcal|0
Size T Iressrt Tegt
deg  Radis[1T41 pm | [ BolateTest
i .
23 >
e \E\ghl
éqsﬁa
\/

o

o deg

Click [Change].
The [Font] dialog box appears.

Cancel

[OMake the selections for the font, style,and size.

L]

Font: Font style: Size 1
O\Aual ]Hegul:r 17 w 0 CIICk [O K]
‘it Black e ;& T | The [Fan Text] dialog box appears again.

Hr AvaniGarde Bk BT Bold n
T AvaniGarde MABT Buold ltalic 11
T BankGothic Md BT 12
T Batang 14
T BatanaChe . 16~

Sample

AaBhbYyZz
Seript
Wwestem ¥

Iest

Fan Text

3

|Happy Birthdayl

Ftation Angle

% -

Font  Arial Lhangs
Pasition I™ Eil Background
—
I Horizontal |0 mm Back Color
4 Vetical [0 mm
o I Invert Tegt
dea  Fadus[TA I~ Rotate Text
i e
AN Heignt 23 mm p
%

FontColor [ |-

7 N
Cancel
N Z
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The typeface of the on-screen text changes.



4-3 Adjusting Brightness and Contrast

Checking the Finished Results in the Preview Window

At the preview window, you can adjust the brightness, contrast, and gamma correction. An image with clearly defined
light and dark areas produces attractive printed results. Adjust to match the image.

Procedure

[Ed e v ooz e GO to the [File] menu and click [Print Preview].

Mew, .. CErl+

Open... ChrHO

Sawve Chrl4+3 H Cancel ‘ielSlandaId‘ Print.. ‘ Zoom | 100% =
Save fs... Bichtness [0 [4] | | Cotest [0 [4] ] ¥ Ganma[05 [3] | ]
Impoart...

Export 3

Material Setup. ..
Add Material 3

Seleck Source...
Acquire..,

prict Ctrl4p

[ ITET=TENT

Preview screen
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4-3 Adjusting Brightness and Contrast

Tips and Tricks for Image Adjustment

WhatYou Can Do in the Preview Window

Brightness
This adjusts the overall brightness. Making the
value too large can destroy the balance, so it

: _ CLEX may be a good idea to adjust it to the absolute

F. fild Cancel |§alSlandardI gint. | Zoom [100% < minimum necessary.
Brightness ]T ¥| Contiast ]TM ] ] Gemma IWMJ ]

Contrast

This mainly adjusts highlights (the brightest ar-
eas) and shadows (the darkest areas). Using this
can be effective when you want to achieve a
sense of tension with a good balance of light
and dark.

—— Gamma
This mainly adjusts the brightness of tones of
intermediate brightness between bright and dark
areas. Using it is effective in adjusting the over-
all brightness.

The dark and bright areas are printed as shown in the figure.
Dark-color areas are not struck, and light-color areas are struck forcefully.

Bright area

Dark area

Also, the printing results before and after adjustment are as shown below.

Before adjusting

After adjusting

i, Gamma adjusted to 0.4.
i‘A'j- The brightness of the face is reduced,
making the expression clearly defined.

\ Hap &
asd opy Birtnd®d
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4-4 Printing Materials of aWideVariety of Shapes

About the Size and Shape of the Printing Area

The size of the image to print must always fit within the size of the material. Printing an image that is larger than the
material may cause the marking pin to strike the edge of the material and break.

Dr. METAZA2 comes preset with quadrilateral, round, and diamond material shapes.

For example, when you want to print material whose shape is not registered in Dr. METAZAZ2, like that shown in the
figure, you must set the area printed to be smaller than the material.

O Material

Printing area

Registering the shape of the material with Dr. METAZA2 makes it possible to expand the printing area.
[ p 54 "Adding a Material Shape"

/7 Hole in the material
() F\/ Material

Printing area
Printing cannot be performed around a hole.

Avoiding Holes in the Material When Printing

When you use the pen feature to black-fill an area in the data by drawing freehand, the filled area is not printed. When
you want to perform printing that avoids a hole in the material, use the pen to fill an area in the data whose size and
location is matched to the hole. You can make the settings for the width of the pen and the like in the [Pen Setup]
dialog box.

0 For detailed information, refer to the online help.

Dr.METAZAZ2 Screen
P Untitled - Dr.METAZAZ =% - 7 Printing area

File Edit View Object Help

DEEHER BB XE -

C—/ Hole in the material

@

L]

]

.

B Be sure to specify black as the color.

> In the Pen Setup dialog box, set the width of the pen to
x match the diameter of the hole in the material.
A

V)

o .

o [Pen Setup] dialog box

o

i Pen & Paint Color

Width

——F = |

Cursor: 13,18, -1,90 mm Position: 0,00, 0,00 mm Size: 20,00, 20,85 mm 100%
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4-4 Printing Materials of a Wide Variety of Shapes

Adding a Material Shape

When you want to use material of a shape other than a circle (ellipse), quadrilateral, or diamond, add the shape.

Creating a Shape Using a Third-party Program

You can use a commercial paint-type program to create a shape, then register it with Dr. METAZAZ2. Vector data cannot
be used. Prepare bitmap data that meets the following conditions.

Number of colors : Binary (black and white -- Fill the interior of the shape with black, and make other portions white
or uncolored.)

File format : BMP or JPEG format

Alternatively, you can acquire (import) the shape of the material using a scanner. You acquire the shape by scanning
the material directly, or by making a paper copy of the shape of the material and then scanning the paper.
[ For detailed information, refer to the documentation for the scanner you're using.
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4-5 Other Handy Features

A Wide Variety of OperationsYou Can Accomplish with Dr. METAZA?2

Dr. METAZA2 offers a wide variety of features for editing imported images and creating printing data. For more
information on how to operate Dr. METAZAZ2, refer to the online help for the program.
0 p 13 "Included Documentation"

Inserting a Frame

You can use frames to decorate images.

You can select the shape and color you want from among the registered frames.

How to display the editing screen : At the toolbar, click [_{| (Frame). Alternatively, at the [Object] menu, click
[Frame].

Registering a Custom-made Frame

You can use a commercial paint-type program to create a shape yourself, then register it with Dr. METAZAZ2.
How to display the editing screen : At the [Object] menu, click [Add Parts], then click [Frame].

Rotating an Image

You can take an image imported into Dr. METAZA2 and rotate it in increments of 90 degrees.
How to display the editing screen :At the [Object] menu, click [Rotate Image].

Cropping an Image

You can crop just the necessary portion of an image. This lets you extract and print the image of a specific person, for
example, or a background image.

How to display the editing screen :At the [Object] menu, click [Crop Image].

Registering a General-use Image

You can register often-used logos and other images as symbols, which lets you call them to the screen simply and
easily. Registering as a symbol an image that allows wide use can shorten editing times. You can also import your own
original images into Dr. METAZA2 and register them as symbols.

How to display the editing screen : At the [Object] menu, click [Add Parts], then click [Symbol].

Importing a General-use Image

You can import an image registered as a symbol.
How to display the editing screen : At the [Object] menu, click [Symbol].

Importing an Image Using a Scanner

If you have a TWAIN 32-compliant scanner, you can call up the scanner driver from Dr. METAZAZ2. This lets you import
and print your own original images.

How to display the editing screen :At the [File] menu, click [Select Source].

How to display the editing screen : At the [File] menu, click [Acquire].
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4-5 Other Handy Features
|

Inverting Gradations
This inverts the gradations of all images displayed in Dr. METAZAZ2. You use this when you want to insert a logo or text

and print it with black and white reversed.
How to display the editing screen : At the [Edit] menu, click [Invert].

Adding Handwritten Text and Hand-drawn Images

You can use the pen tool to add hand-drawn figures and handwritten text to an image.
How to display the editing screen : At the toolbar, click [ (Pen).

When you display the setting window for the pen, you can specify the pen width and color.
How to display the editing screen : At the [Object] menu, click [Pen Setup].
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4-6 ItemsYou Can Set Using the Driver

A Wide Variety Settings You Can Make with the Driver

At the setting window for the driver, you can make the settings for a wide variety of items, including the size of the
material and the method used for printing.

Displaying the Setting Window

Any changes you make at this window (the window displayed by using the procedure described here) remain in effect
even after you restart Dr. METAZAZ2. To continue operations with the changes applied, follow the procedure below to
display the setting window.

Procedure

[] Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Click [Settings], then click [Printers].

[] | Right-click [Roland MPX-70].
i:gﬁ If you're using Windows XP/2000, click [Printing Preferences].
Roland If you're using Windows 98SE/Me, click [Properties].
MPx-70 The setting window appears.
& Roland MPX-70 Printing Preferences @E|
B Material | 8] Image Conection | ] Option
Work Size

Offset
widh (500 oo 4 :
Length [G00 < [a0 = _

Uit

&+ Milimeters |

" Inches [~ Extended Size

[~ Prirt from bottom about...

[~ Bi-Direction
Save Seftings...
Load Settings...
METAZA s
0K, Cancel Help
l )

About the Setting Window

Going to the Dr. METAZAZ2 [File] menu and clicking [Print Setup], then, in the [Print Setup] window, clicking
[Properties], displays the same window as the one that appears using "Displaying the Setting Window," described
above.

Any changes you make while at this window disappear when you restart Dr. METAZA2.When you want to make
temporary changes in driver settings, display the setting window from Dr. METAZA2.
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4-6 ItemsYou Can Set Using the Driver

Material Tab

& Roland MPX-70 Pr=s
] Material B ima

Work Size

width

Length

Uit

+ Millimeters
" Inches [~ Extended Size

[~ Print from bottom

[ Bi-Direction

ADOUL..

METAZA

MMETAL FRINTER M

[ OF. ] ’ Cancel

Save Settings. ..

Load Settings... J

Cre |

Enter the size of the printing area.

This corrects misalignment of the center point.
[ p 70 "Adjusting the Location of the Machine's Origin Point"

This chooses the units of measurement for the width
and length.

This expands the printing area (this can be set up to a
maximum of 80 x 80 mm (3-1/8 x 3-1/8 in.).

However, note that when printing is performed in an
expanded area (that is, outside an area of 50 x 50 mm
(1-15/16 x 1-15/16 in. )), then depending on the mate-
rial and the image, unevenness in darkness may occur.

To view the image during printing while printing is in
progress, make sure this is selected.

Select this when you want to speed up printing times.
Note, however, that printing quality may be slightly
reduced.

This saves the driver settings in a file.

This loads driver settings saved in a file.

Image Correction Tab

& Roland MPX-70 Printing Preferenc

W] Material B Image Corection ] oplion

Carrection alues

Dark Bright
Brightress |0 ﬂ J ﬂ
Low High
Contrast |0 ﬂ J ﬂ
Drark Bright

Garnma W A i

Material

Set Standard I

Brass hd

Details... | )_

O Test
(* Photo

i HighReszalution

METAZA

METAL PRINTER AW

[ 0K ] ’ Cancel

[~ Miror Image:
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This performs adjustment when the printing results are
not what you intended.

U p 74 “The image is unattractive."

This returns the corrected image values to the initial
values before correction (brightness = 0, contrast = 0,
and gamma = 0.5).

This chooses the composition of the material to print.
The optimal striking force for printing the composition
is set.

To fine-tune the striking force, click [Details].

[ p 72 "Adjusting the Striking Force to Match the Material"

This selects the printing mode.

When you're printing an image with clearly defined
outlines, such as text, then select [Text]. When you're
printing an image that contains gradations, such as a
photograph, then select [Photo]. When you want to cut
even small text and intricate patterns attractively, choose
[High Resolution]. Note that the printing time when
you select [High Resolution] takes approximately twice
as long as with [Photo].

—— This prints a mirror image of the printing image.



4-6 ItemsYou Can Set Using the Driver

OptionTab

& Roland MPX-70 Printing Preferences E|fg|

W] Material | B8] Image Cc-rre-:tic-n| &) Option

Correct slope

This adjusts the tilt of the table.

Back
,_‘ Enter the values taken from the results of printing the
Left :I Right test pattern.
l— I—J
=4 Eront - This prints the test pattern for adjusting tilt using
:I Test print | the machine.

[
[0 p 75 "The image is always faint at the same location."

METAZA

METAL FRISTER hiFX

T =
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Chapter 5
Maintenance and Adjustment
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5-1 Daily Care

Daily Care

/AWARNING Never use gasoline, alcohol, thinner, or any other flammable material.
Doing so may cause fire.

ACAUT|ON Never touch the heads immediately after printing has finished.
Doing so may cause burns.

O This machine is a precision device, and is sensitive to dust and dirt. Be sure to carry out day-to-day cleaning.

O Never use solvents such as thinner, benzine, or alcohol.
O Never attempt to oil or lubricate the machine.

Cleaning the Adhesive Sheet

If the adhesive force of the adhesive sheet declines, then wash the sheet.

O Never scrub the adhesive sheet using a scrubbing pad or sponge.
O Never stretch or bend the adhesive sheet when washing it.

Procedure

Press the Power/Movement button to move the table to
the front of the machine.

Power/Movement button

Switch off the power.

Peel off the adhesive sheet from the table.
Grasp the edges of the adhesive sheet and peel it off slowly.

N A N ///f@?f Adhesive sheet
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5-1 Daily Care

[ ] While submersing the adhesive sheet in water, gently stroke the surface of the sheet with your
fingers.

[ ] Allow the adhesive sheet to dry.
Allow to dry completely, out of direct sunlight. It must not be mounted on the table while wet.

[] Place the adhesive sheet on the table.
Adhesive sheet
[] Press down gently on the adhesive sheet at the center and

the four corners.

Mounting the Adhesive Sheet

O Place it straight, aligned with the scale marks on the table.
O Place inside the table frame.
O Be careful not to allow any air bubbles to form between the adhesive sheet and the table.

If the Adhesive Sheet Gets Extremely Dirty

If the soiling of the adhesive sheet is severe, wash it using diluted neutral detergent. Rinse thoroughly with water
to remove all detergent completely.
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5-1 Daily Care

Head Cleaning
Clean away any fine grime around the head. Perform cleaning periodically.

Press the Power/Movement button to move the table to
the front of the machine.

Power/Movement button

Remove the adhesive sheet.

% Adhesive sheet

OLoosen the knob.
OPress the location shown in the figure to lower the head
unit to where it touches the brush.

Head unit

Keeping the area shown in the figure clamped, turn the
knob to secure in place.
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5-1 Daily Care

[ ] Press the Power/Movement button to switch on the power.
The head moves and cleaning is performed.

L]

After cleaning has finished, loosen the knob.

Cleaning the Body and Cover

Use a cloth moistened with water then wrung well, and wipe gently to clean.
The surface of the cover is easily scratched, so use a soft cloth.
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66

5-2 Maintenance of the Marking Pins

The machine's head has nine pins. Printing is performed using these pins one at a time. If the tip of the pin in use
becomes worn, you can change the pin used for printing. You can also perform adjustment to ensure that each pin uses
the same striking force.

You carry out all of these maintenance activities using the included [MPX-70 Head Manager] program.

Starting MPX-70 Head Manager

| i Foland DrMETAZAZ | a4 DrvETAZA2 Click [Start], then click [All Programs] (or [Pro-
& DrMETAZAZ Help grams]).
= ETALAZ Tl

Click [Roland Dr. METAZAZ], then click [MPX-
70 Head Manager].

| ' MP-70 Head Marager

I f.ﬁ MRS

[] Switch on the power to the machine.
PN

U rizad Manager Lninztall

i

Checking the State of the Marking Pins

The state of each pin is shown.

If the indicator for the pin you're using is red, then replace it with a new pin.

If attractive printing is impossible or printed images are uneven even though the scale is not red, then change to a new
pin.

TF MPX-T0 Head Manager - Rola... [= |[51(X]

? Head Manager

Feplace Head... | Readjust Fins...

Selection of the Pin for Marking

It & red indicator iz dizplayed, change to
a different pin.

Amount used

A pin needs to be replaced when it is shown in red.

" No.3:
" Nod:
" No&
" NoE:
" No. 7
" Nog
" No.9:

This indicates the amount of pin usage. The indicator display
increases a little at a time as striking is performed.The rate of
increase varies according to the material printed.

Pins for which nothing is displayed are unused.

Refresh Apply Pin Change

This refreshes the screen to display the latest information.
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5-2 Maintenance of the Marking Pins

Changing the Pin Used for Marking

Follow the steps below to change the marking pin.

Procedure

[ ] Start MPX-70 Head Manager.
[0 p 66 "Starting MPX-70 Head Manager"

[ - 11970 Head Manager -Rola... [2][51][X] JChoose the number of the pin to use next.
? -y OClick [Apply Pin Change].

Replace Head... | Readjust Fins...

Selection of the Pin far Marking

It a red indicatar is displayed, change to
a different pin.

Amount used

Olary

IR
" No4
" No&:
" No.g:
" No.F:
" No.g:
" No.g:

Refrezh @ Apply Fin Change l

OFollow the on-screen instructions to reset the power.
OClick [OK].

.
\!‘) Please do again to turn on the power of MP¥-70
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5-2 Maintenance of the Marking Pins

Adjusting the Striking Force of the Pins

You can individually adjust the striking force of each separate pin. Pin adjustment involves striking the pattern shown
in the figure. Prepare a piece of test-use printing material (brass) or other material measuring about 60 mm (2-3/8 in.)
by 60 mm(2-3/8 in.) .

Adjustment pattern

Procedure

[ ] Start MPX-70 Head Manager.
[0 p 66 "Starting MPX-70 Head Manager"

[ 1/PX-70 Head Manager -Rola... =3 Click [Readjust Pins].
? , Follow the on-screen instructions to perform adjustment for the
ead Manage! K
pins.

| |
Replace Head... @|

Selection of the Pin for Marking

W - 1+7x-70 Head anager -Rota.... (20| When you have finished, click [X].
? - The window closes.
[==1 anager

How to Determine the Adjustment Values

For the adjustment value, use the letter and number of the location where the value that can be read is lightest. If this
is difficult to determine, decide on an appearance (darkness) to serve as a reference, and select a location having the
same appearance. For instance, if the situation is like that shown in the figure, then select the following values.

BO
C3
BO
C —

BY —
C2
C1

34567890123456%
45678901234567:!

O
A —— R A
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5-3 Head Replacement

Replacing the Head

When all nine marking pins wear out, replace the head. During replacement, you strike the pattern shown in the
figure. Prepare a piece of test-use printing material (brass) included with the replacement head (MPH-70), or another
piece of material measuring about 60 mm (2-3/8 in.) by 60 mm (2-3/8 in.).

The replacement head is sold separately. Consult your authorized Roland DG Corp. dealer or Call Center.

Adjustment pattern

Procedure

O Never quit the replacement operation while partway through.
0 The head is a consumable part. Never use a head whose marking pins are all worn out.
O Never reuse a head once it has been removed. Never use it a second time, even if it contains unused pins.

[] Start MPX-70 Head Manager.
[0 p 66 "Starting MPX-70 Head Manager"

[N~ irx 70 Head Manager Rola... [= [0 [X) Click [Replace Head].
? Follow the on-screen instructions to carry out head replacement.
Head Manager

=
(" Replace Head... Readjust Pins...

Selection of the Pin for Marking

I a red indicatar iz dizplayed, change to
a different pin,

Amount uzed
¢ Hol:
" Mo.2
" Mo
" Mo
CoMeb LT T T 1]
CoMob LT TTTT 1]
CMe? LT T T T T 1]
CoMog LT TTTT 1]
MoS LT TTTTT]

Refresh Apply Pin Change

D 7F MPX-70 Head Manager - Rola... E” When yOU have ﬁniShed, CI|Ck [X]

The window closes.
? Head Manager |

After you have finished the head-replacement operation, click [Readjust Pins] to check the state of the marking pins.
[0 p 68 "Adjusting the Striking Force of the Pins"
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5-4 Adjustment of the Origin-point Location

Adjusting the Location of the Machine's Origin Point

The machine's printing origin point is at the center of the table's scale. When you want to adjust the origin-point
location, output calibration data to verify the location of the origin point.

1. Print calibration data.

[] Mount material on the center of the table.
Prepare material measuring at least 20 mm square.
0 p 30 "Mounting Material on the Table"

[] Start Dr. METAZA2.

0Go to the [File] menu and click [Open].
OFor [Look in], select the [Samples] folder.
OSelect [Axis.dmz].

V Click [Open].

@

File name: |Axis.dmz ‘ Open I

Files of tpe: |Dr MET&Z42 File [*.dmz) LJ Cancel

[] Start printing.

2. Measure and type in the correction values.

[] Center line Measure and note down the offset between the centerline
| Positive direction on the table scale and the crossed lines on the material.

by 0.5 mm in the positive direction and the [Length] value is offset

Positive direction by 0.5 mm in the negative direction.
: for [Width]

- Center line

tfor [Length] In the example shown in the figure, the [Width] value is displaced

Material

77{ -0.5 mm

\
—’\‘4—

0.5 mm

[ ] Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Click [Settings], then click [Printers].
The [Printers] folder opens.
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Foland
MP=-F0

& Roland MPX-70 Printing Preferences

@ | B Material | 2] Image Carection | B8] Option

Y Right-click [Roland MPX-70].

f\\':é If you're using Windows XP/2000, click [Printing Preferences].
If you're usingWindows 98SE/Me, click [Properties].

The setting window appears.

wiork Size

Offset
)
NERS

‘wiidth 50.0
Length 50.0

Uit

* Millmeters

" Inches [~ Extended Size
[ Pintfrom bottom %
I BiDirection
Save Seltings
Load Sett
é@LERT”EAnE’yA oad Settings.
-

Entry of Correction Values

5-4 Adjustment of the Origin-point Location

OClick the [Material] tab.
OlIn the width and length fields for [Offset], en-
ter the displacement values you noted in step 1.
OClick [OK].

The window closes.

When the setting window for Dr. METAZAZ is displayed, the values for any settings made there are temporary,

and are not saved.

To save the values in the setting window, go into the [Printers] folder and display the setting window for the driver.
[0 p 57 "AWide Variety Settings You Can Make with the Driver"
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5-5 Registration of Custom Material

Adjusting the Striking Force to Match the Material

Here you register a material and adjust the striking force to match the material's hardness and other parameters.

Procedure

[ ] Windows XP
Click [Start], then click [Control Panel].
Click [Printers and Other Hardware], then click [Printers and Faxes].
Windows 98 SE/Me/2000
Click [Start].
Point to [Settings], then click [Printers].

[] Right-click [Roland MPX-70].
If you're using Windows XP/2000, click [Printing Preferences].
If you're using Windows 98SE/Me, click [Properties].

OClick the [Image Correction] tab.

D & Roland MPX-70 Printing Preferences

B ool - imags Canection ) ] Ot OFor [Material], select a custom material (settings a through
Carrection Yalues — d . . )
Dak B OClick [Details].
bires [ 1] Hﬂh The [Details] window appears.
Law ial
Contrast ’T ﬂ J ﬂ
Dark Eright __J

Gamma H ﬂ J ﬂ M
Material @ '®

O Test
+ Phaoto
" HighReszolution

[~ Mimar Image
METAZA
[] [Hes 3] Adjust the impact values.
e e The printing results vary according to the hardness of the material. Adjust to
Sela ﬂ match the material.
Speed / Impact — Raise
Speedmss) [0 = When dark areas of the image are not struck
Lower
mpact-MIN - [150 = When dark areas of the image are whitish (too bright)
Impact-Mex [380 = When overall striking is too forceful
— Raise
o | corcel_ | = When bright areas of the image are struck with too little force (too dark)
= When overall striking is too weak
Lower

= When white areas of the image are struck with too much force
[] Click [OK].
The [Details] window closes.

[7 Click [OK].

The setting window closes.
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6-1What to Do If

The machine doesn't run even when printing data is sent.

Is the power switched on?

Make sure the Power/Movement button light is on. If it is
dark, press the Power/Movement button to switch on the
power.

Is the power cord connected correctly?
If it is not connected correctly, refer to the page indicated
below and connect it properly.

O p 18 "Connecting the Power Cord"

Is the cable used for the connection to the computer
connected correctly?

If it is not connected correctly, refer to the page indicated
below and connect it properly.

[J p 19 "Connecting to the Computer”

Striking is performed, but nothing is printed.

Has the height of the head been adjusted to match
the thickness of the material?

Check whether the head is at a height that matches the thick-
ness of the material and whether the head is fixed in place
at that height. Printing cannot be performed if the height of
the head doesn’t match the thickness of the material. Align
the head height and fix the head in place securely using the
knob.

Is the material loaded at the correct location?
If striking is being performed at a location other than where
the material is loaded, then reload the material.

Is the material to be printed in line with the param-
eters for printable material?
Prepare and use printable material.

O p 28 "Preparing Material to Print"

Was printing performed at a location such as the
edge of the material?

Printing at the edge of material may bend or break the mark-
ing pin. If nothing is printed, the marking pin may be bent
or broken. Printing cannot be performed if the marking pin
is bent or broken. Change the pin.

[ p 67 "Changing the Pin Used for Marking"

The image is unattractive.

Are the settings for the material in the driver's set-
ting window correct?

Choose the composition of the loaded material.

Even if the composition of the material is the same, the
hardness of the printed surface may vary greatly depending

Chapter 6 Appendix

on the casting method, the composition of impurities, the
presence of plating, and so on. In such cases, perform fine
adjustment of the striking force to match the material.

O p 72 "Adjusting the Striking Force to Match the Material"

Is the image printed clearly?

If the image is not printed clearly, adjust the brightness of
the image. Perform printing while increasing the brightness
of [Gamma] or [Brightness] in the driver's setting window a
little at a time.

At this time, leave the material loaded and perform
overstriking at the same location. Continue changing set-
tings and performing printing until you obtain the darkness
you want.

[ p 57 "AWide Variety Settings You Can Make with the Driver"

Are grayscale tones printed clearly?

If the grayscale tones is not printed clearly, adjust the force
of striking. Perform printing while leaving the value for [Im-
pact--MAX] unchanged and increasing the value for [Im-
pact--MIN] a little at a time.

At this time, leave the material loaded and perform
overstriking at the same location. Continue changing the
settings in the driver's setting window and performing print-
ing until you obtain the darkness you want.

O p 57 "AWide Variety Settings You Can Make with the Driver"

More Information about Overstriking

The various setting values determined with overstriking are
effective only when performing overstriking under identi-
cal conditions. The same results are not necessarily obtained
when printing is performed with a new piece of material
with only the conditions made the same, without perform-
ing overstriking.

Is the marking pin worn?

Attractive printing may be impossible if the marking pin
becomes worn.

Adjust the pin or change it to a new one.

[ p 66 "5-2 Maintenance of the Marking Pins"

The image is uneven.

Is the printed surface slightly uneven?
Replace with material having a level printing surface.

O p 28 "Preparing Material to Print"

Is the printed surface at an angle?
Replace with material having a level printing surface.

[ p 28 "Preparing Material to Print"

Is the image darkness uneven?

Performing overstriking with the material left loaded at the
same location may improve the image quality. Try perform-
ing overstriking with different settings for [Gamma], [Bright-



ness], or [Contrast] in the driver's setting window.

O p 57 "A Wide Variety Settings You Can Make with the Driver"

Was bidirectional printing performed?

Bidirectional printing can shorten the printing time, but the
image quality may suffer. If this happens, go to the driver's
setting window and clear the selection for [Bidirection],
then redo printing.

[ p 57 "AWide Variety Settings You Can Make with the Driver"

Is the marking pin worn?

Attractive printing may be impossible if the marking pin
becomes worn.

Adjust the pin or change it to a new one.

[ p 66 "5-2 Maintenance of the Marking Pins"

The image is always faint at the same location.

If the image is often faint at the same location, such
as near the front right area of the table, then adjust-
ing the levelness of the machine may improve the
image quality.

Please note that this is not effective when uneven-
ness in the image is unrelated to the printing loca-
tion, such as when uneven areas vary from one piece
of material or image to another.

1.Load a piece of included test-use printing material at the
center of the table.

If the included material has been used up, then prepare a
piece of material that is larger than 60 mm and has a smooth-
ness of 0.05 mm or less.

O p 30 "Mounting Material on the Table"

2.Go into the [Printers] folder. Right-click the [Roland MPX-
70] and open the setting screen for the METAZA driver.

If you are using Windows XP/2000, click [Printing Prefer-
ences].

If you are using Windows 98 SE/Me, click [Properties].
3.Click the [Option] tab.

4.Click [Test print].

The test pattern is printed on the material.

5.Use the scale to read and note down locations where the
test pattern is not continuous or not visible. Note down the
values in all four directions (front, back, left, and right).

6-1 What to Do If

6.Select [Correct slope] and enter the scale values you noted
into the driver.

R

2 Roland MPX-70 Pri nting Preferences

] Material | 9] Imane Corection & option

Carrect slope
[ Corect glope Back
iE] =
Left 3 &1
M R
18 =1 Frart ] -
2 4 e |

The printed location isn't where desired

The center of the table scale may not coincide with the
machine's printing origin point.

To correct displacement between the scale center and the
printing origin point.

O p 70 "Adjusting the Location of the Machine's Origin Point"

What to Do If Installation Is Impossible

If installation quits partway through, or if the wizard
does not appear when you make the connection with
a USB cable, take action as follows.

Windows XP/2000

1.If the [Found New Hardware Wizard] appears, click [Fin-
ish] to close it.

2.Display [System Properties].

Windows XP

Click the [Start] menu, then right-click [My Computer]. Click
[Properties].

Windows 2000

Right-click [My Computer] on the desktop. Click [Proper-
ties].

3.Click the [Hardware] tab, then click [Device Manager].
The [Device Manager] appears.
System Properties EJE|

Syztem Restore Remate

General

Autamnatic Uodatae

Computer Marme Advanced

Add Hardware izard
% The Add Hardware Wizard helps you install hardware.

Add Hardware ‘Wizard

Dievice Manager

s The Device Manager lists all the haidware devices installed
aon your computer. Use the Device Manager ta change the

properties of any device.
] Device kanager

[ Diriver Signing
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6-1 What to Do If

4.At the [View] menu, click [Show hidden devices].

5.In the list, find [Printers] or [Other device], then double-
click it.

When [Roland MPX-70] or [Unknown device] appears be-
low the item you selected, click it to choose it.

6.Go to the [Action] menu, and click [Uninstall].
7.The screen shown in the figure appears.
Click [OK].

Confirm Device Removal

A\ Roland MPX70

W arning: You are about ta uninstall this device from your system.

8.Close the [Device Manager] and click [OK].
9.Unplug the USB cable from your computer.
10.Restart Windows, then uninstall the driver.

O p 76 "Uninstalling the Driver"
11.Redo the installation from the beginning.

[0 p 21 "Installing the Driver"

Windows 98 SE/Me

1.Refer to "Uninstalling the Driver" on the following page
and uninstall the driver.

O p 76 "Uninstalling the Driver"
2.Redo the installation from the beginning.

[0 p 21 "Installing the Driver"

Uninstalling the Driver

When uninstalling the driver, perform following op-
eration.

1.Before you start uninstallation of the driver, unplug the
USB cables from your computer.

2.Log on to Windows. If you are installing under Windows
XP/2000, log on as “Administrators” right.

3.Insert the included CD-ROM into the CD-ROM drive.
The setup menu appears.

Go to the upper right and click the [X] to close the setup
menu.

4.From the [Start] menu, click [Run].

Chapter 6 Appendix

5.For [Open], type in the information shown below, then
click [OK].

Windows XP/2000

(CD-ROM drive letter ):\Drivers\WIN2K\SETUP.EXE
Windows 98 SE/Me

(CD-ROM drive letter):\Drivers\WIN9X\SETUP.EXE

The Setup program starts and the [Driver Setup] window
appears.

_ Type the name of a program, folder, document, or

Internet resaurce, and Windows will apen it far you,

Open: U Dn\Drivers\WINEK\SETUP, EXE] ) |

( [e]4 D: Cancel ][ Browse... ]

6.Select [Uninstall], then choose [Roland MPX-70].
Click [Start].

" Install

Iodel:

:

| I

Cancel

7.Click [Yes] to restart the computer

Driver Setup

p |, Restart must be done. Restart now 7




6-2\When Moving the Machine

When moving the machine, be sure to attach the protective materials. Moving the machine without attaching the
protective materials may result in damage to the machine.

Procedure

[] Loosen the knob.
Loosen just enough for the head unit to rise.

[] Press the Power/Movement button to move the table to the front of the machine.

[] Switch off the power.
Unplug the power cord and USB cable.

Attach the protective material B.

Head unit

Stainless-steel portion

Protective material B

/ Table

L
=t )
A

Fit the side in.

Align the front.

/ Lower the head unit and use the knob to secure it in place.

%/ Press down on the entire head unit with your hand.

Head unit
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6-2 When Moving the Machine

Attach the protective material A.

Protective material A

Insert the protective
material inside the
stainless-steel portion.

Stainless-steel portion

[] Close the cover.

[ ] Repack the machine in its original packing carton.

78 Chapter 6 Appendix



6-3 Head Life

The head used in this machine is a consumable part.
As a general guide to its useful life, about 3,600 plates can be printed under the following conditions.

Conditions of Use

Material used : MD-NI (Roland nickel-plated plate)
Printing area : 30 mm (1-3/16 in.) X 23 mm (15/16 in.)
Print Mode : Photo

Printing rate : 35% (25,000 dots per plate)
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I 6-4 Locations of the Power Rating and Serial Number Labels

Serial Number

This is require when you seek maintenance,
servicing, or support. Never peel off the label
or let it get dirty.

Power Rating

Use an electrical outlet that meets the re-
quirements for voltage, frequency, and am-
perage given here.
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6-5 Main Unit Specifications

MPX-70

Printable material

Gold, silver, copper, platinum, brass, aluminium, iron, stainless steel, etc.
(Vickers hardness [HV] of the printing surface must be 200 or less.)

Loadable material size

Maximum 90 mm (width) x 90 mm (height) x 20 mm (thickness)
(3-1/2in. x 3-1/2 in. x 3/4 in.)

Printing area

80 mm x 80 mm (3-1/8 in. x 3-1/8 in.)

Resolution

529 dpi(High resolution), 353 dpi (Photo), 265 dpi (Text)

Printing direction

Unidirectional printing or bidirectional printing (Selectable with Windows driver)

Printing speed (Default)

50 mm/sec (1-15/16 in./sec)(Photo), 33 mm/sec (1-5/16 in./sec)(High resolution/Text)

Interface

USB interface (compliant with Universal Serial Bus Specification Revision 1.1)

Power supply

Dedicated AC adapter
Input : AC 100 to 240V + 10% 50/60Hz 1.7A
Output : DC 19V 2.1A

Power consumption

Approx. 15W

Acoustic noise level

Under 70 dB (A) (According to ISO 7779)

Operation temperature

10 to 30°C (50 to 86°F)

Operation humidity

35 to 80% (no condensation)

External dimensions

226 mm (W) x 321 mm (D) x 200 mm (H)
(8-15/16 in. (W) x 12-11/16 in. (D) x 7-7/8 in. (H))

Weight

4.0 kg (8.8 Ib.)

Packed dimensions

350 mm (W) x 440 mm (D) x 350 mm (H)
(13-7/8 in. (W) x 17-3/8 in. (D) x 13-7/8 in. (H))

Packed weight

6.5 kg (15 Ib.)

Accessories

AC adapter, power cord, test-use printing material, USB cable, CD-ROM, user's manual
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Please read this agreement before opening the sealed disk package
Opening the sealed disk package implies your acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in the disk package ("Software") under this agreement with the following terms and conditions.

1. Coming into Force
This agreement comes into force when you purchase and open the sealed disk package. The effective date of this
agreement is the date when you open the sealed disk package.

2. Property

Copyright and property of this Software, logo, name, manual and all literature for this Software belong to Roland
and its licenser. The followings are prohibited:

Unauthorized copying the Software or any of its support file, program module or literature.

Reverse engineering, disassembling, decompiling or any other attempt to discover the source code of the Soft-
ware.

3. Bounds of License

Roland does not grant you to sub-license, rent, assign or transfer the right granted under this agreement nor the
Software itself (including the accompanying items) to any third party.

You may not provide use of the Software through time-sharing service and/or network system to any third party
who is not individually licensed to use this Software.

You may use the Software by one person with using a single computer in which the Software is installed.

4. Reproduction

You may make one copy of the Software only for back-up purpose. The property of the copied Software belongs
to Roland.

You may install the Software into the hard disk of a single computer.

5. Cancellation

Roland retains the right to terminate this agreement without notice immediately when any of followings occurs:
When you violate any article of this agreement.

When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability

Roland may change the specifications of this Software or its material without notice.

Roland shall not be liable for any damage that may caused by the use of the Software or by exercise of the right
licensed by this agreement.

7. Governing Law

This agreement is governed by the laws of Japan, and the parties shall submit to the exclusive jurisdiction of the
Japanese Court.
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